TYPESETTING GUIDELINES
Professional Typography Tips to Up Your Game!




Bad Formatting

You've seen a Word Document with such horrible, inconsis-
tent formatting that it makes you want to scream.

You've probably also seen a PUBLISHED and PRINTED book
with such horrible formatting (and spelling mistakes) that you
want to scream.

If you're a book designer, it can be hard to know which rules
to follow. Do I indent here? Should | let this list flow to the next
page? Everyone says different things about ellipses! Let's fix
that. The key is consistency.

Just as the Holy Bible gives us an anchorpoint for our morals,
we need a “Bible” for our graphic design guidelines. This de-
sign anchorpoint is the Chicago Manual of Styles.

When you are designing a professional book, it is published
for the world to see, so it's important to have consistent, ap-
proved design in the book's interior. People judge a book
by its cover and then proceed to analyze the interior design
as they read.

Typesetting Terms
O Verso/Recto

These terms refer to the left- and right-hand pages in a spread

0O Leading

The vertical distance between lines of text. Derived from the time
when typesetting was done with actual lead block letters

0O Tracking

The horizontal spacing between a range of letters or characters

0 Kerning

The horizontal spacing between two individual letters

0 Typeface

A distinguishable set of letters, digits, and other characters all
following the same style. Examples: Garamond, Calibri, Times New
Roman, Comic Sans (ew).

0O Font

A file that contains the images of all characters in a typeface.
Examples: TimesNewRomanRegular.otf, CalibriBold.ttf

Our graphic design formatting “Bible.”

VERSO

| |

\ /

Left-havd page Right-hand page

RECTO

Hendandae net esti Hendandae net esti
velitam aliquidundam
cum si officae. Iducime velitam aliquidundam

vollupt atendus.
cum si officae. Iducime

Tight and loose

“leading” vollupt atendus.
Hendandae net esti Hendandae net esti
velitam aliquidundam velitam aliquidundam
cum si officae. Iducime  cum si officae. Iducime
vollupt atendus. vollupt atendus.

Tight and loose “tracking”

design

L Bad kerving

design

Good kerving )
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Title Pages & Hyphens

CHAPTER ONE | 1

No rumning headers on title pages! \J

HEADER

—"\oloriscid ex evellaborero volut audanihilla nos aut

lagn veriant
l Po. The first paragraph of a title page ur sitis S@
dia should have vo first line indewt -dam voloru

exerum sitalur, volenihilicae dolore inctemp orer
debisssi dist, quassum netus, conse res ilitem quidu

lit andae es doluptaquos sunt eum sandam verum._
untipsamuseum utemgue ommosnatestia t
bus am hilluptaquis dolorrore ex enda } usciisnosary
que et aceatur ionsequatium aut volorep editas solupta
ipidexperovid maio tetur mi, officii sseftaqui oditas nia
porem est voluptatof ficiu ritatur mofuptatWe peribus
as nonsequossin nistin nobiti aut venj ullam conet latur
a voluptatem cone eaquae volenda de dolorep taspitios
voluptatur?

Mus cum qui ulla et
laborep rehente asseque num net anf ratur, a eius, utem
nus doloria nditempor reribus eliae daquo et esenis ex
evelign atetur? Lorpos quidus, offici §orem aut verferr
untinti simus.

lhillau temgue mincim doluptior
corporem alitiam endaeri squibus eos delladiai
amusci alibero bernatur acietur? Fre r, a eius, utem Ny
doloria nditempor reribus eliae eagquo et esenis ex e
lign atetur? Lorpos quidus, official oodsf cot quaturi.

Too many hyphens on one page

Check for:

0 Running Headers

Also known as the “folio,"—the informative bar at the
top of the page which usually contains page numbers,
the name of the author/book, or chapter title—should
not be present on title pages.

0O Indent
The first paragraph of body copy shall not have a first
line indent.

0O Hyphens

Hyphens should be reduced and, if possible, entirely
removed. If hyphens are necessary, there shall be no
more than two to three per page, and never one fol-
lowing another.

HEADER

Voloriscid ex evellaborero fret volut audanih gomm illa
nos aut lam veriant.

Porernatus audit officab oreped quatatur sitis
sendia dolorios ulla pra ex esciliqui re, cus audam
volorum exerum sitatur, volenihilicae dolore inctemp
orerundebisssi dist, quassum netus, conse res ilitem
quidunt lit andae es doluptaquos sunt eum sandam
verum untipsamuseum utemgue ommosnatestia quat
aturibus am hilluptaquis dolorrore ex enda idusciisnosam
que et aceatur ionsequatium aut volorep editas solupta
ipidexperovid maio tetur mi, officii ssectaqui oditas nia
porem est voluptatof ficiu ritatur moluptatWe peribus
as nonsequossin nistin nobiti aut veni ullam conet latur
a voluptatem cone eaquae volenda de dolorep taspitios
voluptatur?

Mus cum qui ullabo. Nam, simporum nosam et
laborep rehente asseque num net ant ratur, a eius, utem
nus doloria nditempor reribus eliae eaquo et esenis ex
evelign atetur? Lorpos quidus, offici corem aut verferr
untinti simus.

lhillau temgue mincim doluptior ma doluptate
corporem alitiam endaeri squibus eos dellacipit et
reptamusci alibero bernatur acietur? Fre r, a eius, utem
nus doloria nditempor reribus eliae eagquo et esenis ex
evelign atetur? Lorpos quidus, official codsf cot quaturiae.

Good to Know

As seen in the examples above,
“lorem Ipsum” is a long-standing
form of filler text, based on mod-
ified Latin, but the words mean
nothing. If you can translate Lorem
Ipsum for me, I'd love to hear it!
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Widows, Orphans, & Section Breaks

vetrentggndi quatiori ghfghipic ias sit volorep erspit at
ipsunt, sed maion pa vel et aci conse voluptia eate num
nestiumetur sumqui te et velendiam, corendi repudig
nisiminimos denimporest odignat.

Mus cum qui ullabo. Nam, simporum nosam et

laborep rehen’ r, a eius, utem

No “orphavs!” The last line of
a paragraph should always
have at least +wo words /€M aut verferr

o et esenis ex

nus doloAda n

milici od quosam nonestis modit andunt, nonsequae
sapit, consequam voluptiis non praeris doloriassi dolor
rendige nimusam, quis parum sumgue volore con rem
quatias nam quatium cuptatemost ex evelibus denisti
optat volorro vitiat quatetumet fugia doluptatem eicab
idus, occullab illamus iume cum faccae volorrovidi int
estruptaqui rest fugitiam, vit dolorepe labo. Nam, iducid
evelestiatas a everspe rnatiun temqui conserspit di cul-
lent eos ma quiatia sum quia idenissunda entorendunt
endant hil magnit magnihilla quoditaturit voluptas sitat.
Epediorunt, ommodicidem volenim enecto dolup-
tae nobisquam id quidist vel id exerat.
After a section break flourish,

the first paragraph should

have vo first line indent.

F—— Electo modi culparunt rectatene nis estrum ra sequo
magnat molumaqu iscidem conse maionse quideliti sum
alitatur aritate placers piciis ea similique estibus eum nos
as mo coreste nossimi, incienis sim rehent

Ovid magnatur? Bore nonsedianditatem nonsecum

quiaeptur ab in eaquia quam aut que pratibus nissi acea
iusam guam re, sitions equideliqui cus reium volo et
omnimeodis ad molorib uscilluptur? Num fugit, eat msam

daepe liquatur?

vetrentggndi quatiori ghfghipic ias sit volorep erspit at
ipsunt, sed maion pa vel et aci conse voluptia eate num
nestiumetur sumqui te et velendiam, corendi repudig
nisiminimos denimporest odignat.

Mus cum qui ullabo. Nam, simporum nosam et
laborep rehente asseque num net ant ratur, a eius, utem
nus doloria nditernpor reribus eliae eaquo et esenis ex eve-
lign atetur? Lorpos quidus, offici corem aut verferr simus.

Et harum aceperepel maion et illaccumaue dolor
milici od quosam nonestis modit andunt, nonsequae
sapit, consequam voluptiis non praeris doloriassi dolor
rendige nimusam, quis parum sumgque volore con rem
quatias nam quatium cuptatemost ex evelibus denisti
optat volorro vitiat quatetumet fugia doluptatem eicab
idus, occullab illamus iume cum faccae volorrovidi int
estruptaqui rest fugitiam, vit dolorepe labo. Nam, iducid
evelestiatas a everspe rnatiun temqui conserspit di cul-
lent eos ma quiatia sum quia idenissunda entorendunt
endant hil magnit magnihilla quoditaturit voluptas sitat.

Epediorunt, ommodicidem volenim enecto dolup-
tae nobisquam id quidist vel id exerat.

Electo modi culparunt rectatene nis estrum ra sequo
magnat molumaqu iscidem conse maionse quideliti sum
alitatur aritate placers piciis ea similique estibus eum nos
as mo coreste nossimi, incienis sim rehent

Ovid magnatur? Bore nonsedi anditatem nonsecum
quiaeptur ab in eaquia quam aut que pratibus nissi acea
iusam quam re, sitions equideliqui cus reium volo et
omnimodis ad molorib uscilluptur? Num fugit, eat msam
ipsandaepe liquatur?

Agnisqu ibusdan dandenienimo volore quaepudi
qui con por sed etur mo optae omnimus es alitis escia
nos quodit, nit landunt faccusa nimi, conecest aborestem
aut etum dundae nihicipsam, in pore por sit dolenih illore
es ma dereptate plabori tasperum ium alit, ium vendit
ratem delendam nissinu llabor accaecae alit rectur? Quia
con pra volescid et landic tet am et eum venihicias exer-
spient labo. Ovid mi, tem quis quam lacitiundae. Debis
soluptatat.

Osautomniet quaspedis quatur aliquia consecte por
aut que porae nonsed ma volore exerferis mi, sed quatum
ratem facerro blacepr orestrum iuntio bea verchic tore-
ritas inci reri ulliquia nessece ssitatem que dolecto corit
mossus ex evendem porporem aut molum nus, cora con
reiunt velique nus, simus inus.

Mus cum qui ullabo. Nam, simporum nosam et
laborep rehente asseque num net ant ratur, a eius, utem
nus doloria nditempor reribus eliae eaquo et esenis ex
evelign atetur? Lorpos quidus, offici corem aut verferr
untinti simus.

Apellectet quaspel ius modi toremoluptae ne dolup-
tam eatiant.

Laccabo. Et ad que dipiciunt omnimenis exces sunt
eumquiates a solorpossit quatum qui illum num alicicum
hil ipit volut remolup taquamus, ut omnis minis nistiam
di occum fugiaturi officim inctusam, utem rate es explis
est magnihitam uteceperum aceaquam enimus derovid
et eatur, tem reic torem fuga. Ut el modiam isque archilic
tem landi con nus, se omnimi, quosapi entissinciae
dolupta tempor rem dolo optate nus sin raestio. Nam que
vendaest venditiis re et ulluptat estiati quia pel iur abor-
essum la nonse praecte volor sit optas dis sint, ut eum ra
nulla niam rentum voluptiam ea commod unt ad minctio.

No “widows!” The top of a new
page should atways have at
least +wo lives of text

TSRS g dandenienimo volore quaepudi
qui con por sed etur mo optae omnimus es alitis escia
nos quodit, nit landunt faccusa nimi, conecest aborestem
aut etum dundae nihicipsam, in pore por sit dolenih illore
es ma dereptate plabori tasperum ium alit, ium vendit
ratem delendam nissinu llabor accaecae alit rectur? Quia
con pra volescid et landic tet am et eum venihicias exer-
spient labo. Ovid mi, tem quis quam lacitiundae. Debis
soluptatat.

Osautomnietquaspedis quaturaliquia consecte por
aut que porae nonsed ma volore exerferis mi, sed quatum
ratem facerro blacepr orestrum iuntio bea verchic tore-
ritas inci reri ulliquia nessece ssitatem que dolecto corit
mossus ex evendem porporem aut molum nus, cora con
reiunt velique nus, simus inus.

Mus cum qui ullabo. Nam, simporum nosam et
laborep rehente asseque num net ant ratur, a eius, utem
nus doloria nditempor reribus eliae eaquo et esenis ex
evelign atetur? Lorpos quidus, offici corem aut verferr
untinti simus.

Apellectet quaspel ius modi toremoluptae ne dolup-
tam eatiant.

Laccabo. Et ad que dipiciunt omnimenis exces sunt
eumgquiates a solorpossit quatum qui illum num alici cum
hil ipit volut remolup taquamus, ut omnis minis nistiam
di occum fugiaturi officim inctusam, utem rate es explis
est magnihitam uteceperum aceaquam enimus derovid
et eatur, tem reic torem fuga. Ut el modiam isque archilic
tem landi con nus, se omnimi, quosapi entissinciae
dolupta tempor rem dolo optate nus sin raestio. Nam que
vendaest venditiis re et ulluptat estiati quia pel iur abor-
essum la nonse praecte volor sit optas dis sint, ut eum ra

Check for:
O Orphans

This is the term applied to words that are left on
their own line at the end of a paragraph

0O Widows

This term describes what happens when the last
few lines of a paragraph end up alone on the top
of the next page.

0O Section Breaks

At the beginning of any new section—whether
that be after a flourish or at the beginning of a
new chapter—the first paragraph of body copy
shall not have a first line indent.
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2 | Book Title

aguag o mi dero gun yo fsd opil tata ericop xdkjglk xedr
iutr ansada plis iun wesum facepsed fret gret ro delibus

Lists

CHAPTER ONE | 3
N\ If at all possivle, the list

contents should remain on the
same page

pa doluptatata dolorro odi omnissi as eaquamet por aut
eafgg te mqaue idd fg fghf fghes a vfertyedfihujiopseddghf
gh fghs olo tggo vetrentggndi quatiori ghfghipic ias sit
volorep erspit at ipsunt, sed maion pa vel et aci conse
voluptia eate num nestiumetur sumgui te et velendiam,
corendi repudig nisiminimos denimpeorest cdignat.

Mus cum qui ullabo. Nam, simporum nosam et
laborep rehente asseque num net ant ratur, a eius, utem
nus doloria nditempor reribus eliae eaquo et esenis ex eve-
lign atetur? Lorpos quidus, offici corem aut verferr simus.

Et harum aceperepel maion et illaccumgue dolor
milici od guosam nonestis modit andunt, nonsequae
sapit, consequam voluptiis non praeris doloriassi dolor
rendige nimusam, quis parum sumgue volore con rem
guatias nam quatium cuptatemost trex.

Evelibus denisti optat volorro vitiat quatetumet fugia
doluptatem eicab idus, occullab illamus iume cum faccae
volorrovidi int estruptaqui rest fugitiam, vit dolorepe labo.
Nam, iducid evelestiatas a e freg to up y el dog i freg top
dreop for the berg ode gret plop verspe rnatiun temqui
conserspit di cullent eos ma quiatia sum quia idenissunda
entorendunt endant hil magnit magnihilla quoditaturit
voluptas sitat. Epediorun.

= Ovid maaratir? P~ra nnansedi anditatem nonsecum
quiaer After alist, the following r que pratibus nissi acea
iukar Paragraph should remove the Jui cus reium volo et
o first line indent

om
ipsandaepe liquatur?

Agnisgu ibusdan dandenienimo volore quaepudi
qui con por sed etur mo optae omnimus es alitis escia
nos quodit, nit landunt faccusa nimi, conecest aborestem
aut etumn dundae nihicipsam, in pore por sit dolenih illore
es ma dereptate plabori tasperum ium alit, ium vendit
ratem delendam nissinu llabor accaecae alit rectur? Quia
con pra volescid et landic tet am et eumn venihicias exer-
spient labo. Ovid mi, tem quis quam lacitiundae. Debis
soluptatat.

Os aut omniet quaspedis quatur aliquia consecte
por aut que porae nonsed ma volore exerferis mi, sed
quatum ratem facerro blacepr orestrum iuntio bea verchic

luptur? Num fugit, eat msam

toreritas inci reri ulliquia nessece ssitatem que dolecto
corit mossus ex evendem porporem aut molum nus, cora
con reiunt velique nus, simus inus.

Mus cum qui ullabo. Nam, simporum nosam et
laborep rehente asseque num net ant ratur, a eius, utem
List1 The list items should be styled with
List 2 secondary lines that fall directly be-
List neath the copy, ot extending below

+he bullet or margin

nus doloria nditempor reribus eliae eaquo et esenis ex
evelign atetur? Lorpos quidus, offici corem aut verferr
untinti simus.

Apellectet quaspel ius modi toremoluptae ne dolup-
tam eatiant.

Laccabo. Et ad gque dipiciunt omnimenis exces sunt
eumgquiates a solorpossit quatum qui illum num alici cum

Check for:

2 | Book Title CHAPTER ONE | 3

aquag o mi dero gun yo fsd opil tata erioop xdkjglk xedr
jutr ansada plis iun wesum facepsed fret gret ro delibus
pa doluptatata dolorro odi omnissi as eaquamet por aut
eafgg te mque idd fg fghf fghes a vfertyedfihujiopseddghf
gh fghs olo tggo vetrentggndi quatiori ghfghipic ias sit
volorep erspit at ipsunt, sed maion pa vel et aci conse
voluptia eate num nestiumetur sumaqui te et velendiam,
corendi repudig nisiminimos denimporest odignat

Mus Et harum aceperepel maion et illaccumque
dolor milici od quosam nonestis modit andunt, nonse-
quae sapit, consequam voluptiis non praeris doloriassi
dolor rendige nimusam, quis parum sumque volore con
rem quatias nam quatium cuptatemost trex.

Evelibus denisti optat volorro vitiat quatetumet fugia
doluptatem eicab idus, occullab illamus iume cum faccae
volorrovidi int estruptaqug to up y el dog i freg top dreop
for the berg odp verspe rnatiun temqui bret up o ref dup
were conserspit di cullent eos ma quiagnihilla quaturit
voluptas sitat. Epediorun.

« List1
+ List2
+ List3
« List4
« List 5, which is really quite long and will probably
drop to the next page.
« Listé
« List7
« List8
« List9

Ovid magnatur? Bore nonsedi anditatem nonsecum
quiaeptur ab in eaquia quam aut que pratibus nissi acea

iusam quam re, sitions equideliqui cus reium volo et
omnimodis ad molorib uscilluptur? Num fugit, eat msam
ipsandaepe liquatur?

Agnisqu ibusdan dandenienimo volore quaepudi
qui con por sed etur mo optae omnimus es alitis escia
nos quodit, nit landunt faccusa nimi, conecest aborestem
aut etum dundae nihicipsam, in pore por sit dolenih illore
es ma dereptate plabori tasperum ium alit, ium vendit
ratem delendam nissinu llabor accaecae alit rectur? Quia
con pra volescid et landic tet am et eum venihicias exer-
spient labo. Ovid mi, tem quis quam lacitiundae. Debis
soluptatat

Os aut omniet quaspedis quatur aliquia consecte
por aut que porae nonsed ma volore exerferis mi, sed
quatum ratem facerro blacepr orestrum iuntio bea verchic
toreritas inci reri ulliquia nessece ssitatem que dolecto
corit mossus ex evendem porporem aut molum nus, cora
con reiunt velique nus, simus inus.

Mus cum qui ullabo. Nam, simporum nosam et
laborep rehente asseque num net ant ratur, a eius, utem
nus doloria nditempor reribus eliae eaquo et esenis ex
evelign atetur? Lorpos quidus, offici corem aut verferr
untinti simus

Apellectet quaspel ius modi toremoluptae ne dolup-
tam eatiant.

Laccabo. Et ad que dipiciunt omnimenis exces sunt
eumquiates a solorpossit quatum qui illum num alici cum
hil ipit volut remolup taquamus, ut omnis minis nistiam
di occum fugiaturi officim inctusam, utem rate es explis
est magnihitam uteceperum aceaquam enimus derovid
et eatur, tem reic torem fuga. Ut el modiam isque archilic
tem landi con nus, se omnimi, quosapi entissinciae
dolupta tempor rem dolo optate nus sin raestio. Nam que

O List Indent

If the list items are long and have more than
one line of text, they need to be styled with text
aligned beneath the above copy, not extending
below the bullet or to the left-hand margin.

0O Page Flow

If at all possible, lists should not extend to the
following page or spread.

0O After the List

Following a list, the first paragraph of body copy
shall not have a first line indent.
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End of Chapter Pages

4 | BookTitle

vendaest venditiis re et ulluptat estiati quia pel iur abores-

sum la nonse praecte volor sit optas dis sint, ut.

LTM@ last page of the chapter should
have at least 4-5 lines of text

X

Check for:

O Number of Lines

The last page of the chapter should have at least 4-5
lines of text, if at all possible.

0O Running Headers

If the last page of your chapter is entirely blank (to
preserve title page order on the recto side), then no
running header should be applied. The page will be
entirely blank.

4 | BookTitle

que vendaest venditiis re et ulluptat estiati quia pel iur
aboressum la nonse praecte volor sit optas dis sint, ut

eumn ra eturit quas dendit vercient, expersped quidi bea

verfere rsperibea que eat et dolor sequame nus alitatat
estiis eat ur autem. Ut omnisti atibea que nis sim evellaut
qui dolorro dis maximus dolupta.

Mus cum qui ullabo. Nam, simporum nosam et
laborep rehente asseque num net ant ratur, a eius, utem
nus doloria nditempor reribus eliae eaquo et esenis ex
evelign atetur? Lorpos quidus, offici corem aut verferr
untinti simus.

Good to Know

In this guide, all body copy in the
examples is seen as “left justified,”
which aligns the text to both the
left and right margins, while start-
ing the last lines on the left. This
is the standard setting for almost
any printed book in existence, as it
improves readability.
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X

Debis soluptatat..... Os aut

Debis soluptatat... Os aut

This is a regular space (spacebar) and
should not be used with ellipses

Ellipses are one of the most confounding subjects
to research in the graphic design world. It's rare
to find two sources who agree! While a majority
would advocate for the use of an ellipse glyph (a ...
contained within a single character file), the Chica-
go Manual of Styles prefers another method.

Check for:

O Ellipse Characters

Although it seems counter-intuitive, the Chicago
Manual of Styles does not want ellipse glyphs used in
the text.

0O Periods with Breaking Spaces

The familiar dot-space-dot-space-dot is another no-
no. This kind of formatting will not keep the periods
together and they can become separated across line
breaks or even pages.

Good to Know

If you are working in Adobe InDe-
sign, you can see a visual represen-
tation of the invisible punctuation
used in your document, indicated
by the light blue dots and carats in
my examples above.

Navigate to:

View>Structure>Show Structure

v

Debis soluptatat.....Os aut

Debis soluptatat....{

This is a nonbreaking space and will
keep the periods from separating or
breaking lines

Do Instead:

O For an Excerpt

For an excerpt in the middle of a quote, use this
format:

period—nonbreaking space—period—non-
breaking space—period

For excerpting the beginning of a sentence, the
following sentence’s period becomes part of the
line-up:

period—nonbreaking space—period—non-
breaking space—period—nonbreaking space—
period

0O Forthe Endofa Line

If the ellipse follows at the end of the line due to
a discontinued thought or an excerpt, then the
format is as follows:

period—nonbreaking space—period—non-
breaking space—period—nonbreaking space—
end of paragraph

Good to Know

To insert a nonbreaking space in Adobe InDe-
sign, navigate to:

Type>Insert White Space>Nonbreaking Space
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Dashes

X v

‘nissinu-llabor - accaecae - alit rectur?-

o . nissinu llabor—accaecae—alit rectur?-
‘nissinu-llabor — accaecae — alit rectur?

While em dashes are acceptable, putting ,
spaces aroumnd thewm is vot

Dashes are seen and used in almost every way Do Instead:

imaginable, especially on social media. We have o

. 0O Em Dashes For Explaining a Clause
become accustomed to seeing regular dashes
Em dashes can be used in place of a colon or semi-

used in place of a proper en or em dash (mostly colon. They help to summarize or expand upon the

due to the fact that our keyboards are not natu- following clause. Examples:
rally equipped with these!) O Grandma loved—with her homegrown toma-
toes—to cook spaghetti sauce.
CheCk for' O Inside the sauce were my favorite ingredi-
O Regular Dashes ents—tomato, basil, cilantro, and onion.
These should not be used anywhere! The only ex- 0O En Dashes for Increments

ception is hyphenated words (like pick-me-up). En dashes indicate a span of time, numbers, or

O En or Em Dashes with Spaces dates. Examples:

These dashes should always bump up against their 0 9am-1p.m.
neighbors without any white space. 0 12,000-15,000

0 June-August

0O Regular Dashes for Hyphens

GOOd to Know Regular dashes are used as hyphens in some com-
pound words. Examples:

EN DASHES and EM DASHES refer 0O Pick-me-up

to the length of a dash in a type- O Self-esteem

face. Naturally, the EN DASH is the
length of the letter “n” and the EM

0O Anti-virus

DASH is the length of the letter “m.”

In Adobe InDesign, these dashes
can be inserted here:

Type>Insert Special Character>
Hyphens and Dashes

Becky@BeckysGraphicDesign.com | 615.562.7148




